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Preparing a Folder 
• Note – Saving the PowerPoint show and all associated files in the same folder helps everything stay 

connected and working when moved to another computer. 
• Click on Start  My Documents. 
• On the Menu Bar, click on File  New  Folder. 
• Type in a name for the PowerPoint folder. 

Checking Your Toolbars 
• On the Menu Bar, click on View º Toolbars. 
• Click in the box to select the desired toolbars. 
• Toolbars that already show have a checkmark by them. 

Arranging Toolbars on Separate Lines  
 On the Menu Bar, click on Tools Customize 

and click on the Options tab. 
 Click to place a checkmark in front of Show 

Standard and Formatting toolbars on two rows. 
 Click on the Close button. 

Adding a Shortcut Button to a Toolbar 
 On the Menu Bar, click on Tools Customize 

and click on the Commands tab. 
 Choose the desired Category from the box on the left then select the Command from the box on the right. 
 Click and drag the command to the desired toolbar. 
 Click OK. 
 To remove a command from a toolbar, hold down the Alt key then click and drag the toolbar button off of 

the toolbar.  
 Note: To reset a toolbar: 

• Click on Tools Customize and click on the Toolbars tab. 
• Select the desired toolbar.  
• Click on the Reset button then click on OK. 

Customizing the Menus 

Seeing the Full Menu 
• On the Menu Bar, click on Tools þ Customize and choose the Options tab. 
• Click to place a check mark in front of Always show full menus. 
• Click on the Close button. 
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Creating a Photo Album 

Selecting Pictures 
• From the menu select Insert  Picture  New Photo Album. 
• In the Insert Picture From: section: 

o Click on the File/Disk button. 
o Navigate to the pictures to include in the Photo Album. 
o Use Ctrl+A to select all of the pictures or press the Ctrl key while clicking randomly to select 

the desired pictures. 
o When the desired pictures have been selected, click on the Insert button. 

• If there are more pictures to be added to the Photo Album from another location: 
o Click on the File/Disk button. 
o Navigate to the location of the pictures. 
o Select the desired pictures. 
o Click the Insert button. 

• Note the Scanner/Camera button and the Insert Text Box buttons for two other ways of adding content to 
the Photo Album. 

Organizing and Managing Pictures 
• To rearrange the order of the pictures, click on a picture In the 

Pictures in album window and use the up or down arrows at the 
bottom of the window.  

• To delete a picture from the list, select a picture in the Pictures 
in album window and click on the Remove button. 

• To select a layout for the pictures, click in the Picture layout 
dialog box then choose an option from the drop-down window.  

• Notice the preview window to the left of the Layout list. 
o After selecting the Picture layout select a Frame shape 

by clicking the Frame shape: dialog box that is now available.    
• When the desired album options have been 

selected click on the Create button. 
• Add a title to the Title slide that was created 

by navigating to slide 1 and clicking in the 
Photo Album field.  

Making Changes to a Photo Album 
• Note – Any changes made to a Photo Album outside of the Format window will be lost, moved to its own 

slide, or moved to the end of the slide show. 
• In the Menu Bar, click on Format  Photo Album. 
• To rearrange the order of the pictures, click on a picture In the Pictures in album window and use the up 

or down arrows at the bottom of the window.  
• To delete a picture from the list, select a picture in the Pictures in album window and click on the Remove 

button. 
• To add new pictures, click on the File/Disk button. 
• To change the Album Layout: 

o Click on the drop-down arrow next to Picture layout: 
o Click on the drop-down arrow next to Frame Shape: to choose a border for the pictures. 
o Click on the Browse button and double click on the Presentations Designs Folder to select a 

Design Template. 
• Click on the Update button. 
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Compressing Pictures 
• Note - Compressing pictures reduces the file size of the 

presentation, making it more manageable when moving it, sending 
it by email, etc. 

• Click on a picture.  
• Click on the Compress Picture button on the toolbar. 
• In the Apply to section, choose All pictures in document. 
• In the Change resolution section, choose Web/Screen. 
• In the Options section, make sure both options are checked. 
• Click on OK. 

Changing the Background of a Slide  

Changing to a Solid Color with no Background Graphics 
• In Normal View, click the slide to be changed. 
• On the Menu Bar, click Format þ Background... OR right-click in a blank area of 

the slide and choose Background... 
• Click on the down arrow near the bottom of the window and choose a color. 
• Click to place a checkmark in front of Omit background graphics from master.  

(This will omit accents and other graphics included in the master slide.) 
• Click on OK. 

Using Fill Effects, Patterns, etc. as a Background 
• In Normal View, click on the slide to be changed. 
• On the Menu Bar, click on Format þ Background... OR right-click in a blank area of the slide and 

choose Background... 
• Click on the down arrow near the bottom of the window and choose a color. 
• Click on Fill Effects.... 

Applying a Gradient Background 
• Click on the Gradient tab. 
• Choose One color, Two colors, or Preset.  
• Choose color(s) as appropriate. 
• Choose shading styles and variants as appropriate. 
• Click on OK. 
• Choose to either apply the background to all slides (Apply 

to All) or to the selected slide only (Apply). 

Applying a Textured Background 
• Click on the Texture tab. 
• Choose a texture. 
• Click on OK. 
• Choose to either apply the background to all slides (Apply to All) or to the selected slide only (Apply). 

Applying a Pattern Background 
• Click on the Pattern tab. 
• Click on one of the pattern choices. 
• Choose a Background and Foreground color. 
• Click on OK.  
• Choose to either apply the background to all slides (Apply 

to All) or to the selected slide only (Apply). 
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Applying a Picture Background 
• Click on the Picture tab. 
• Click on the Select Picture button. 
• Navigate to the location of the desired picture.  
• Click on the picture then click on the Insert button. 
• Click on OK. 
• Choose to either apply the background to all slides (Apply to All) or to the 

selected slide only (Apply). 

Using a Picture as a Watermark for the Background  
• Insert a picture on the desired slide by selecting Insert Picture From File. 
• Click on the picture to select it. 
• Resize the picture using the bounding handles to fit on the slide. 
• On the Picture Toolbar click on the Color button and select 

Washout.  
• To position the picture behind all other objects on the slide, right-click on the picture and select Order 

Send to the Back. 

Using the Drawing Toolbar 
• The Drawing Toolbar is usually at the bottom of the PowerPoint Window. 
• If the Drawing Toolbar has not been turned on select View Toolbars Drawing. 

 
 

Drawing Shapes from the Drawing Toolbar 
• Click on the desired tool, move the mouse to the slide, press the left mouse button and drag the mouse to 

draw the shape or field. 
• Release the mouse button and the object will have sizing handles around it. Place the mouse pointer over 

one of the handles, press the left mouse button and drag to resize. 
• To delete an object, click on the object to select it then press the Delete key on the keyboard. 

Changing the Fill and Line Properties 
• Click on the object to select it. 
• From the Drawing Toolbar change the following: 

o Fill Color     
o Line Color 
o Font Color 
o Line Style 
o Dash Style 
o Arrow Style 
o Shadow Style 
o 3D Style 

Grouping Objects 
• Click on one of the objects to select it. 
• Hold down the Ctrl key and click on each additional object. 
• Right click on one of the selected objects and choose Grouping  Group. 
• Note – To ungroup, right click on the grouped object and choose Grouping  Ungroup. 
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Ordering/Layering Objects 
• Right click on the object and choose Order  and the desired option. 

o Bring to Front puts the object on top of all other objects. 
o Send to Back puts the object behind all other objects. 
o Bring Forward puts the object above another object. 
o Send Backward puts the object behind another object. 

Adding a Text Box 
• On the Drawing Toolbar click on the Text Box button or from the menu click on Insert Text Box.  
• Click and drag on the slide to create a text box where the text will wrap as you type. 

o Note: If the mouse is clicked without dragging, the text that is typed will not wrap unless the Enter 
key is pressed. 

• After typing the text, click on the hashed lines around the text field to select everything inside and then 
change the desired text properties, i.e., font style, color, size etc. 

Deleting a Text Box 
• Click in the text box. 
• Click on the border of the text box. 
• Press the Delete key on the keyboard. 

Adding a Fill Color or a Border to a Text Box 
• Click on the desired text box to select it. (i.e., title field, bulleted list field, text box) 
• Click on the Fill button on the Drawing toolbar to fill the background with the selected 

color. 
o To make the color transparent, slide the Transparency Slider to the desired 

level. (The higher the percentage, the more transparent the color becomes.) 
• Click on the Line Style button to add a border with a desired thickness around the text box.  
• Click on the Line Color button to select the desired line color for the border. 

Adding Word Art 
• On the Drawing Toolbar click on the Insert WordArt button or from the menu click on 

Insert Picture WordArt. 
• Click on the desired style of WordArt. 
• Press the OK button.  
• Select the desired font style and size. 
• Type in the desired text. 
• Click the OK button. 

Editing WordArt 
• Use the handles around the outside of the 

WordArt to rotate or resize. 
• Use the WordArt Toolbar to change the 

color, shape, or alignment.  

Adding AutoShapes 
• On the Drawing Toolbar click on the AutoShapes button or from the menu 

click on Insert  Picture  AutoShape. 
• Click on the category of AutoShapes that you wish to make a selection from. 
• Click on the desired shape within the category. Your cursor should now 

display as a cross hair on the slide. 
• Click and drag to create the shape. 
• Type any desired text into the AutoShape. 
• Click away from the shape when you are finished. 
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Editing AutoShapes 
• Click on the AutoShape object to select it. 
• Use the handles which appear around the outside of the AutoShape to resize, rotate, or redirect the shape. 
• Use the buttons on the Drawing Toolbar to change the color or outline properties of the shape OR double-

click the shape to open the Format window. 
• To add text, make sure the object is selected then start typing OR right-click in the object and choose Add 

Text. 

Applying Formatting to the Master Slide 
• From the menu select View  Master  Slide Master. 
• Changes you make to the master slide will be applied to every slide including any new slides. 

o Examples might be, changing the font size and color, bullet style, adding a fill color to a field, 
adding a logo. 

• Changes need to be made to each field on the slide. 
• When finished making the desired changes click on Close Master View 

from the Slide Master Toolbar. 

Working with Charts 

Inserting a Chart  
• In the Normal View, from the menu click on Insert Chart.  

The Datasheet 

• The Datasheet contains information used to create the chart. 
• In the first column, replace East, West, North and South with 

your own data. 
• In the top row, enter the titles for the information fields 

beginning with the cell below A. 
• Enter data in the appropriate cells. 
• Notice that the chart is built as you enter the data. 
• The scale of the grid is determined automatically according to the values of the data. 
• When finished entering data click outside of the box that surrounds the chart. 
• Note: If you click on the red “X” in the upper right corner of the data sheet, it will turn off the data sheet. 

To turn on the Datasheet, on the Menu Bar, click on View  Datasheet. 

Editing the Chart 
• Clicking away from the chart or the datasheet will close the editing 

window. 
• To edit the chart again, double-click on the chart. 

Changing the Chart Type 
• Double-click to select the chart then from the menu click on 

ChartþChart Type.... 
• Choose the type of chart. 
• Note: Click on the Click and Hold to View Sample button to view the 

data in that type of chart. 
• Be sure to look at the sub-types of each type of chart. 
• Click on OK. 
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Changing the Chart Options 
• Double-click to select the chart then from the menu click on 

Chart þ Chart Options....  
• Click on the appropriate tab. 

o Titles - Add titles to the chart and the axes. 
o Axes - Adjust the axes. 
o Gridlines - Choose which gridlines to use. 
o Legend - Choose the position of the legend. 
o Data Labels - Choose to show or not show data 

labels. 
o Data Table - Allows the data table to be shown or 

not shown. 
• Make the desired changes. 
• Click on OK. 

Working with Tables 

Inserting a Table  
• In the Normal View, from the menu click on Insert Table.  
• Choose the number of Rows and Columns. 
• Click on OK. 

Editing a Table 
• Click once inside the table to edit the table.  

o Note: When a table is selected the table toolbar should appear. If the Table toolbar does not 
automatically appear, click on View Toolbars Table and Border.   

• Use the toolbar or right-click in the table to make changes. 

Working with Diagrams 

Inserting a Diagram 
• In the Normal View, from the menu click on Insert Diagram.  
• Choose the type of diagram. Options include: Organization Chart, Circle Diagram, Radial Diagram, 

Pyramid Diagram, Venn Diagram and Target Diagram. 
o Note: To see a description of each type of diagram, click on the diagram then notice the note at the 

bottom of the window.  
• Click on OK. 

Editing a Diagram 
• Clicking away from the diagram will close the editing window. 
• To edit the diagram again, double-click on the diagram. 
• Each diagram has its own editing toolbar. When a diagram is in the edit mode, the toolbar appears. Use the 

toolbar or right-click in the diagram to make changes. 
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Creating Hyperlinks 

Creating a Hyperlink to a Web Address 
• Hyperlinks can be set on a picture, object or a text 

box. 
• Note: If you visit the desired web page before 

starting this process, the URL of the web page will 
be stored for you by PowerPoint. 

• In Normal View, right-click on a picture or text 
box that you have inserted onto a slide and select 
Hyperlink. 

• From the buttons on the left, click on Existing File 
or Web Page then click on the Browsed Pages 
button.  

• Click on the desired web site to paste the URL into the address slot. 
o Note: If the desired website is not listed, click on the Browse the Web button in the upper right 

corner and search for the desired website on the Internet. 
• Click the OK button. 
• To test the link, right click on the object and choose Open Hyperlink. 

Using the Hyperlink 
• From the Menu Bar, click on Slideshow þView Show. 
• Click on the linked picture. 
• After a few seconds the Internet browser will open. 
• When finished, click the red X in the upper right corner of the Internet window OR click on the Back 

button on the Toolbar to return to the slide show. 

Changing Hyperlink Colors 
• On the Menu Bar, click on View þTask Pane. 
• In the Task Pane, click on the down arrow and choose Slide Design – Color Schemes. 
• At the bottom of the Color Schemes window, click on Edit Color Scheme…. 
• Click on the Custom tab. 
• Click on the color box in front of Accent and hyperlink and/or Accent and followed hyperlink. 
• Click on the Change Color…. 
• Choose the desired color. 
• Click on OK. 
• Click on the Apply button. 

Removing the Hyperlink 
• Right-click on the linked object and select Hyperlink... 
• Click on Remove Hyperlink. 

Linking to a Slide in a Slideshow 
• Right-click on an object and select Hyperlink. 
• From the buttons on the left, click on the Place in This 

Document button. 
• Click on the desired slide in the slide show. 
• Click the OK button. 
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Action Buttons 
• Action Buttons are an obvious way of linking to other locations in the slide show. 
• Click on the slide where the hyperlink will appear. 
• Click on the AutoShapes button on the Drawing Toolbar. 
• Choose Action Buttons and click on one of the button choices. (i.e. Action Button: Back or Previous) 
• Click and drag on the slide to create the Action Button. 
• In the Action Setting window, make sure the Mouse Click tab is selected. 
• Click on the down arrow below Hyperlink to: 

o Choose the appropriate option for the button. 
o The Slide… option allows other slides in the slide show to be chosen. 

 Click on the desired slide to link to. 
 Click OK. 

o Click OK. 
• To change or modify the hyperlink, right click on the button and choose Edit Hyperlink…. 
• To remove the hyperlink, right click on the button and choose Remove Hyperlink. 
• To change the color, double click on the button. 

Linking to a File or Document 
• Note: Files or documents that will be used in a slideshow should be copied or moved to the same folder as 

the slideshow prior to inserting the file or document. 
• Right-click on an object and select Hyperlink. 
• From the buttons on the left, click on the Existing File or Web Page button then click on the Current 

Folder button. 
• Click on the down arrow next to the Look in: box and navigate to the location of the file. 
• Click on the desired file then click on OK. 

Movies and Sounds 

Downloading Movies and Sounds 
• Find the movie or sound on the Internet. 

o For a list of sounds sites, go to http://www.davis.k12.ut.us/district/etc/cathy/sounds.html  
o Note - Be sure to notice the warning at the top of the web page. 

• Right click on the link for the movie or sound. 
• Choose Save Target As.... 
• Navigate to the PowerPoint slide show folder. 
• Change the name if desired. 
• Click on Save. 

Inserting Movie Clips or Sounds from Files  
• Note: Movies and sound files that will be used in a slideshow should be copied or moved to the same 

folder as the slideshow prior to inserting the movie or sound. 
• On the Menu Bar, click on Insert þ Movies and Sounds þ Movie from File… or Sound from File…. 
• Navigate to the location of the movie or sound. 
• Click on the movie or sound then click on OK. 
• Choose Yes to automatically have the movie or sound play when the slide appears on the screen or NO if 

the movie or sound will be controlled by a mouse-click. 
• Click and drag the speaker icon to a corner or other inconspicuous area off the slide. 

http://www.davis.k12.ut.us/district/etc/cathy/sounds.html
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Inserting Music from a CD 
• Select the slide where the music should begin. 
• Insert the CD in the CD ROM drive. 

o Close or cancel any requests to play the CD. 
• On the Menu Bar, click on Insert þ Movies and Sounds þ Play CD Audio Track. 
• Choose the Track and the desired Starting and Ending times. 
• To play the track over and over again, click on the Loop until stopped box. 
• Click OK. 
• Choose Yes to have the sound play when the slide opens. 
• Choose No to have the sound a clickable icon only. 
• Notice the CD icon in the middle of the slide. 
• Click and drag the CD icon to a corner or other inconspicuous area off the slide. 

Controlling when the music plays 
• Click in the slide where the music is located. 
• On the Task Pane, click on the down arrow and choose Custom Animation or right-

click on the slide and choose Custom Animation. 
• Click on the media object in the list. 
• Click on the down arrow at the right of the object and choose Start on Click, Start with 

Previous, or Start after Previous. 

Controlling how long the music plays 
• Click in the slide where the music is located. 
• On the Task Pane, click on the down arrow and choose Custom 

Animation or right-click on the slide and choose Custom 
Animation. 

• Click on the down arrow of the media object and choose Effects 
Options.... 

• Click on the Effects tab. 
• Choose when the sound should Start playing. 
• Choose when the sound should Stop playing. 

o Note: To play the music through multiple slides, choose After # slides and enter the desired 
number of slides that the music will continue through. 

• Click OK. 

Recording Your Own Sounds 

Setting the Microphone to Record 
• From the Start button, click on All Programs þ Accessories þ Entertainment þ Volume Control. 
• Click on Options þ Properties. 
• Fill in the Recording radio button. 
• Ensure that the Microphone checkbox is checked. 
• Click the OK button. 
• Check the Select box for Microphone in the “Recording 

Control” dialog box which next appears. 
• Close the dialog box by clicking on the red X in the upper 

right hand corner. 



 

Page 12 
Updated by Cathy Larsen  1/4/2006 

Recording Sounds in PowerPoint 
• From the menu click Insert þ Movies and Sounds þRecord Sound. 
• Click on the round red button to record your sound.  
• Click on the black rectangular button to stop recording. 
• Click on the triangle button to play. 
• Click the OK button when done. 

Recording Sounds Using Sound Recorder 
• From the start button click All Programs þ Accessories þ Entertainment þ Sound Recorder. 
• Click on the round red button to record your speech. 
• Click on the black rectangular button to stop recording. 
• Click on the double back arrows button to rewind. 
• Click on the triangle button to play. 

Starting Over  
• From menu click File þ New. 
• Click the NO button so that the file is not saved. 

Cleaning up the Recording 
• Play the recording and press the Stop button just before the desired sound begins. 
• From the menu click Edit þ Delete Before Current Position. 

Saving the Recorded Sounds 
• From the menu click File þ Save as. 
• Select the desired location and provide a file name. 
• Click on the Save button. 

Inserting Previously Recorded Sounds 
• From the menu click Insert þ Movies and Sounds þ Sound from File. 
• Navigate to the location of the sound that has been saved. 
• Click on the sound then click on OK. 
• Choose Yes to automatically have the sound play when the slide appears on the screen or NO if the sound 

will be controlled by a mouse-click. 

Slide Show Options 

Setting up the Slideshow 
• From the menu select Slideshow þ Set Up Show 
• Select the desired show type. 

o Presented by speaker (full screen) 
o Browsed by an individual (window) 
o Kiosk (half screen) 

• Select the desired show option. 
o Loop until Esc is pressed 
o Show without narration 
o Show without animation 

• Select the desired method to advance the slides. 
o Manual 
o Timed 

• Select the desired pen color. 
• Click the OK button. 
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Using the Pen 
• While playing the show press Ctrl P. 
• Click and drag the mouse to “write” on the screen. 
• Press the letter E on the keyboard to erase. 
• Press Ctrl+A or ESC to change from the pen to the arrow cursor. 

Hiding a Slide 
• Click on the slide that needs to be hidden. 
• From the menu click on Slideshow þ Hide Slide. 
• Note: A line is drawn through the slide icon indicating that when played, the slide will not be displayed. 
• Undo by clicking on the slide again and choosing Slideshow þ Hide Slide again. 

Creating a Custom Show 
• A single presentation can be adapted to a variety of audiences by creating custom shows. 
• From the menu click on Slideshow þ Custom Shows. 
• Click on the New button. 
• Type a name for the custom show in the Slideshow Name box. 
• Under Slides in Presentation select the slides that will be 

included in the custom show then click on the Add button.  
o Note: To select multiple slides, hold down the Control 

key as you click the slides. 
• To change the order in which slides appear, select a slide under 

Slides in Custom Show then click one of the arrows to move 
the slide up or down in the list. 

• Click on OK. 

Saving: Advanced Formats 

Saving a Show That Opens in the Play Mode 
• From the menu click on File þ Save As. 
• Click on the drop down arrow next to Save As Type. 
• Select PowerPoint Show (*.pps) 
• Select a saving location, type a file name and click the Save 

button. 

Saving as a Web Page 
• This is not the option to use for placing the slide show on a DSD Web Design site. Instead, it is an option 

for viewing a slide show in an Internet browser. 
o For DSD Web Design, use the ppt file type and limit the file size by compressing the pictures. 

• From the menu click on File þ Save As Web Page. 
• Select a saving location for the files. 

o You may want to create a folder to contain all the files. 
o Right-click and select New þ Folder. 
o Type in a name for the new folder. 
o Double click on the new folder to open it. 
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• Click the Publish button to set the publishing options. 
o Uncheck Display Speaker Notes. 
o Check the box for All Browsers Listed Above. 
o Change the Page Title by clicking the Change button. 
o Check the box to Open published Web page in browser. 
o Change the saving location by clicking the Browse button and 

navigating to your new folder. 
o Click the Publish button. 

• Preview your web page and then click the red X in the upper right corner 
to close the Internet browser. 

• The folder is now ready to be published to the web. Once the folder is published, you can link directly to 
the .htm file you just created from another web page. 

Burning to a CD 
• Place a CD in the drive. 
• Open Roxio’s Easy CD Creator.  
• Navigate to the PowerPoint slide show folder. 
• Click to select the folder. 
• Click the Add button. 
• When you have added all desired files, click the red Record 

button. 
• Click on the Options button. 

o Select Finalize Session, Don’t Finalize CD if you wish to 
add additional files to the CD. 

o Select Finalize CD if you want the CD to play on any CD 
player. 

• Click the Start Recording button. 
• Note: A progress bar will update you on the CD burn. 
• When completed you will be notified. Click the OK button. 
• When asked to save the CD Project select No. 

Tips and Tricks - Playing the Slide Show 
 

Keyboard Specials 

Action Keystroke Action Keystroke 

Increase Volume “+” Decrease Volume “-“ 

Previous Slide Left Arrow key or 
Page Down key 

Next Slide Right Arrow key, 
Spacebar key, Page Up 

key, or Enter 

Go to the first slide Home key Go to the last slide End key 

Stop the slide show Esc key   
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Using the Mouse 
• While showing the slide show, move the mouse to the bottom left 

corner. 
• Click on the up arrow OR right click on the slide. 

Using Go 
Slide Navigator 

• Choose Go þ Slide Navigator. 
• Choose the desired slide from the list.  
• Click on the Go to button. 

By Title 
• Choose Go þ By Title. 
• Choose the desired title from the list. 
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